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CHAPTER 1 OVBI"VZBW

Luminosity combines the Eclipse IDE and Eclipse C/C++ IDE from the Eclipse
Foundation with the Lynx Cross-Development Environment to facilitate the
development of embedded applications on LynxOS-178 targets.

The Luminosity v5.1.1 BETA Release Notes provide information on the following
topics:
* Luminosity features for this release.

» Error messages that can be displayed on attempt to communicate with
targets via LOCI and the description of possible troubleshooting actions.

+« Known issues and limitations for this release.

For detailed information on the Eclipse IDE and Eclipse C/C++ IDE, please refer
to the online Eclipse documentation installed with the Luminosity product or visit

nttp://www.ec LL pse.org

s - .

Supported Host and Target Systems

The following table provides a summary of the supported host and target
configurations for this release of Luminosity.

Table 1-1: Supported Host and Target Configurations

k. rt T t k. F . 'S
Supported Host Systems Suppt‘). ed Targe Supported Target System
Systems Hardware
Red Hat Enterprise Linux 6.2 (64-bit) | LynxOS-178 2.2.4 PowerPC
Windows 7 (64-bit) LynxO0S-178 2.2.4 PowerPC
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Overview

Host System Requirements

Software Requirements

The following software must be installed on the host to provide access to all
facilities of Luminosity:

» To enable the online help:

- Mozilla or Firefox for the Linux Host

- Microsoft Internet Explorer version 6.0 or higher for a Windows Hosts
* Lynx Cross-Development Environments for LynxOS-178.

For instructions on how to install the LynxOS-178 Cross-Development
Environment, please refer to the respective Lynx Software Technologies,
Inc. documentation:

- LynxOS-178 2.2.4 BETA Installation Guide

« The LOCI 5.1.1 host components installed on the development or
intermediate host. Additionally, LOCI 5.1.1 target components should be
installed in the Cross-Development Environment. For instructions on
how to install the LOCI components, please refer to the LOCIv5.1.1
BETA Release Notes.

» If access to the SpyKer tracing tool is desired, SpyKer 5 target
components should be installed in the Cross-Development Environment.
Refer to the SpyKer 5.1.1 BETA Release Notes for instructions on how to
install the SpyKer tracing tool.

* The expect, telnet, ssh, bash, and xterm utilities accessible from
the PATH variable if direct access to targets is required (on the Linux host
only).

NOTE: Luminosity does not require Java VM installed on the target. Luminosity
installs JRE 1.7 in its own installation directory and uses it while running.
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Hardware Requirements

Depending on a host system, the Luminosity product requires the following
amount of free hard disk space:

« 280 MB on a Linux host system
+ 260 MB on a Windows host system

The host system should have at least 256 MB of RAM. To get better results,
512 MB or more of RAM is recommended.

Luminosity is a Java application; therefore, a I GHz (or more) host processor is
recommended.

Target System Requirements

Betore using Luminosity, make sure that a target system meets the requirements
described in the following subsections.

Kernel Requirements
The subject kernel configuration must include the following:

» A TCP/IP layer enabling network connections (Ethernet), if the network-
based connection with the target will be used

» Depending on the desired number of open sessions, a sufficient number
of pseudo tty devices (at least 1)

+ Serial port driver, if the target does not support network connection or the
subject console should be available from the Luminosity workbench

Luminosity v5.1.1 BETA Release Notes 3
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Other Requirements

Other subject system requirements include the following:

+ Sufficient file system space must exist to support the downloading and
developing of target components and applications on the target.

» Ifanetwork is used for target connection, Cross-Development tools (such
as inetd/xinetd and optionally sshd) must be installed and
configured on the target.

» The LOCI target components must be installed and configured on the
target.

NoTE: If the LOCI target component is absent, the full set of facilities provided by
Luminosity is not available for the user. However, it is possible to manage projects,
edit, compile, and link code using Luminosity. In this case, all target connections
must be made manually.

New Features

The following new features are supported in this release of Luminosity comparing
with the releases 4.0.x:

+ Anew baseline — Eclipse IDE 4.4.0 and Eclipse CDT 8.4.0
« Support for LynxOS-178 v2.2.4 BETA target systems
+ Kernel-level debugging

Version Information

This release of Luminosity contains Eclipse IDE 4.4.0 and Eclipse C/C++ IDE
8.4.0 for the following:

* Linux platforms and the GTK windowing system

«  Windows 7 platform
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Typographical Conventions

The typefaces used in this manual, summarized below, emphasize important
_concepts. All references to filenames and commands are case-sensitive and should

be typed accurately.

Kind of Text

Body text; italicized for emphasis, new
terms, and book titles

Environment variables, filenames,
functions, methods, options, parameter
names, path names, commands, and
computer data

Commands that need to be highlighted
within body text, or commands that must be
typed as is by the user are bolded.

Text that represents a variable, such as a
filename or a value that must be entered by
the user, is italicized.

Blocks of text that appear on the display
screen after entering instructions or
commands

Keyboard options, button names, and menu
sequences

Examples

Refer to the Luminosity v5.1.1 BETA
Release Notes

1s -1 myprog.c /dev/null

login: myname
# cd /usr/home

cat <filename>
mv <filel> <filelZ>

Loading file kdi into

0x=4000

/tftpboot/shell.

File loaded. Size 1s 1314816

© 2015 Lynx Software Technologies,
Inc. Bll rights reserved.
Enter, Ctrl-C
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For More Information

For more information, refer to the following documentation:

»  Luminosity 5.1.0 Installation Guide

This document contains details on supported Host and Target System
requirements as well as procedures for installing and uninstalling
Luminosity.

* Luminosity 5.1.0 User s Guide
This document contains details on Cross-Development Environment
administration, creating application projects, as well as importing,

building, running, and debugging all associated projects using the
Graphical User Interface (GUI).

» SpyKer 5.1.1 BETA Release Notes

This document contains details on the features and late-breaking
information about the current release of SpyKer.

«  SpyKer 5.1.0 Target Guide

This document outlines the procedures on how to prepare, statically link,
and dynamically install a SpyKer Device Driver. Other information
contains instructions on how to build Kernel and File System Images for
LynxOS-178 targets in both Development Mode and Production Mode.

« [LOCI5.1.1 BETA Release Notes

This document contains details and late-breaking information about the
current release of LOCIL.

« LOCIS5. 1.0 User's Guide

This document outlines the procedures on how to run the LOCI proxy, the
LOCI boot service daemon, and the LOCI server. It further contains
important information on how to build LOCI enabled target images.
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Technical Support

Lynx Software Technologies handles support requests from current support
_subscribers. For questions regarding Lynx Software Technologies products,
evaluation CDs, or to become a support subscriber; our knowledgeable sales statt
will be pleased to help you. Please visit us at:
http://www.lynx.com/corporate/contact/support.php3

How to Submit a Support Request

When you are ready to submit a support request, please include a// of the following
information;

+ First name

» Last name

*  Your job title

* Phone number

+  Fax number

+ E-mail address

*  Company name

» Address, City, State, ZIP, Country

*  LynxOS-178 version number [LynxOS-178 v2.2.4 BETA]

+ Target Platform (for example, PowerPC)

« Board Support Package (BSP)

» Current Service Pack Revision

« Development Host OS version

« Detailed description of the problem that you are experiencing:
- Isthere arequirement for a US Citizen to work on this issue?
- Priority of the problem — Critical, High, Medium, or Low?

- Test Cases or Log Files that substantiate or elaborate the problem?

Luminosity v5.1.1 BETA Release Notes 7
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Where to Submit a Support Request

By E-mail:

Support, Europe

tech_europe@lynx.com

Suppo.r'r._ worldwide except Europe support

(@lynx.com

el

Training and Courses USA: training-usa@lynx.com
Europe: training-europe@lynx.com

By Phone:

Training and courses

USA: +1 408-979-4353
Europe: +33 1 30 85 06 00

Support, Europe
(from our Paris, France office)

+33 130859396

Support, worldwide except Europe and Japan
(from our San José, CA, USA headquarters)

+1 800-327-5969 or
+1 408-979-3940

Support, Japan

+81 33 449 3131

By Fax:

Support, Europe
(from our Paris, France office)

+33 130850606

Support, worldwide except Europe and Japan
(from our San José, CA, USA headquarters)

+1 408-979-3945

Support, Japan

S

+81 22 449 3803
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Special Notes

The following notations highlight any key points and cautionary notes that may
“appear in this manual.

NOTE: These callouts note important or useful points in the text.

CAUTION! Used for situations that present minor hazards that may interfere with
or threaten equipment/performance.

Additional resources are available at the following web sites:

« http://www.lynx.com

» http://www.eclipse.org

Luminesity v5.1.1 BETA Release Notes 9
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awmns Known Issues and Limitations

This chapter provides a summary of the known issues and limitations within this

release.

General Issues

Although the Luminosity User's Guide and the Luminosity Installation
Guide may mention versions of the product as “v5.1.0” and/or
“LynxOS-178 v2.2.3, these documents are applicable to “v5.1.1” and
“LynxOS-178 2.2.4 BETA™.

When working with LynxOS-178 2.2.4 BETA, follow the instructions
that are outlined for LynxOS-178 v2.2.3.

If Luminosity runs on Centos 6.6 witha cairo version that is less than
1.9.4 and a GTK version that is greater or equal to 2.24, Luminosity may
crash when printing the following error message:

java: cairo-misc.c:380:
_cairo operator bounded by source: Assertion
‘NOT REACHED’ failed

In order to fix this, add the following line in the end of the
<inst dir>/eclipse/luminosity.ini file:

-Dorg.eclipse.swt.internal.gtk.cairoGraphics=false
where <inst dir>isa Luminosity installation directory.

The Luminosity IDE must be started in the native host environment. That
is, the Luminosity IDE shall not be started from the shell where the
SETUP.bash command is executed to access the Cross-Development
Environment.

Luminosity v5.1.1 BETA Release Notes 11
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Installation Issues

Uninstallation of the Luminosity IDE can fail if another user has made a
previous attempt. Should this occur, remove the Luminosity installation
directory from the command prompt.

Build Issues

In external projects if the active configuration is changed and the project
is rebuilt, information about the executable format displayed in the
Project Explorer view may be incorrect. To avoid this, collapse the project
in the Project Explorer view before rebuilding it.

Sometimes a project can be built twice if the Build Automatically option is
switched on in the main Projects menu.

A project is not automatically re-built after the D2U conversion. Use the
Clean Project menu item to rebuild it.

Driver project build can fail if the driver entry points duplicate names
already present in the Kernel.

Clicking the Apply and OK buttons in the LW Project Properties dialog
while build is running may cause the Luminosity IDE hanging for a few
minutes.

If a Kernel project is built the Duplicate paths warning can appear in
the Problems view. This warning is generated because the Release and
Debug configurations have the same output directory for Kernel projects.
Safely ignore this message.

On the Windows hosts when a very first project is created and built, the
Program g++/gcc not found in PATH error messages is displayed
in the Problems view. Delete this message or ignore it.

12 Luminosity v5.1.1 BETA Release Notes
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Project Issues

When a Cross-Development Environment is removed from the list of
platforms supported by a Kernel project the corresponding directories are
not deleted.

all and clean are reserved for target names in project Makefiles and
cannot be used as project names.

Mutex cannot be used as a project name.

Names such as memory, streambuf, and strings are reserved for C++
header files and cannot be used as project binary names. Refer to the
Window->Preferences->C/C++=>File Types dialog for the full list of the
reserved names.

A project cannot be created in a read-only directory. No error messages
will be displayed.

In the VCT editor for LynxOS-178 Kernel projects, if a value set by the
NumOfVms variable differs from the number of present VM sections a
dialog printing the following message will appear:

The following errors were detected on parsing and will be
fixed:

The value of NumOfVms parameter does not equal to number of
VM sections. Are you sure that yvou want to continue?

Clicking the OK button will adjust the variable to the number of sections.
The same situation occurs if the number of DDD sections is not equal to
the NumOf Ddds value or number of FS sections is not equal to the
NumOfFs value.

In the editor, the built-in C/C++ parser may show errors that are not
printed by the compiler on a project build. Ignore these errors as they will
disappear after the Luminosity IDE is relaunched.

The Makefile files in the Kernel and managed driver projects are
read-only. On attempt to change them, a dialog suggesting to allow write
access privileges appears. Should the user agree to allow write access
privileges, all changes will then be lost.

The Luminosity spec editor does not support spec files with m4
directives. Do not change these files in the Luminosity Kernel projects by
using either external or internal editors after the pure spec files without
m4 directives are produced by the project build. Instead, change the pure
spec file.

Luminosity v5.1.1 BETA Release Notes 13
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The Luminosity VCT editor does not support VCT files with m4
directives. Do not change these files in the Luminosity Kernel projects by
using either external or internal text editors after the pure VCT files
without m4 directives are produced by the project build. Instead, use the
Remote System Configuration -> Edit VM Configuration... item in
the context menu to change VM configuration.

Kernel images built by the Luminosity Kernel and driver projects do not
display information about the build date and the Operating System
version upon initial booting.

In LynxOS kernel projects, if a kernel spec file contains aclspec
directive, the $SENV PREFIX/etc/groups file should be included in the
target file system. Otherwise ACL permissions will be ignored.

Debug and Run Issues

14

Luminosity v5.1.

If the Luminosity IDE or Debug view is closed while the debug session is
still running, the application being debugged may continue running,
therefore preventing a subsequent upload. As a workaround. close the
application on the target before uploading.

If the standard debug engine is used, the line pointer may have a color
that does not correspond to color of threads being debugged. This can
occur if more than one thread is stopped on the same line. Move one of
the threads ahead and the line pointer color will be updated properly.

Variables in the Variables view might be displayed with an error mark and
the subscription Target is not suspended. When the application
stops, this error mark disappears.

An attempt to debug applications built for another platform may cause
the Target selection failed error message.

When multi-thread applications are debugged, the selection in the Debug
view may be lost.

Each time the debug session is launched, the involved project is rebuilt.
The premium features are not supported if the DSF debug engine is used.
The DSF debug engine is not supported for kernel projects at this time.

Debugging and running applications via the serial line may run unusually
slow. Use the network connection if it is possible.

1 BETA Release Notes
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The tracepoints functionality is not complete at this time, and therefore
may produce errors.

If the DSF debug engine is used and the Terminate button is clicked while
in the debug session, the application process may continue running on the
target. Kill the application process on the target manually.

The exited debug session may show an unanticipated gdb exit code in the
Debug view.

When the debugger is stopped inside a function without source code
available, the Editor view shows the message No source available
for (<function>()) and the source of the debugged project
disappears. Position the calling stack to move toward the frame with
source.

The Modules and Signals views are not supported for the DSF debug
engine at this time.

Opening the debug session may occasionally fail. Should this occur,
initiate the operation again.

A debug session can fail to launch if the Binaries folder is not displayed in

the Project Explorer view. Switch between workspaces to restore the
folder.

Serial port sharing between the console and kernel debugger does not
work at this time.

The Message Queues view may display incorrect information for
LynxOS-178 targets.

The Conditional Variables view may not properly display the correct
count value for LynxOS-178 targets.

Kernel debugging may at times be very slow. The debug session may not
perform correctly if an action is started before the previous action
completes. Enable the Verbose option to examine if messages are
exchanged between the host and the target. Start a new action such as
Step Into, Step Over, etc. only after the messages stop printing.

The target may hang if kernel debug session is open and a breakpoint is
set while the kernel is In a running state.

Within the kernel debug session, some threads may be marked as out of
control.

Luminosity v5.1.1 BETA Release Notes 15
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Kernel debugging does not work on LynxOS vpx6 185 and LynxOS
bs77 targets at this time.

The first watchpoint in a debug session does not work on LynxOS
xp5400 p3041 targets at this time.

The debug control buttons in Debug view may inadvertently become
enabled before the debug session is fully established.

Hardware watchpoints are not supported on LynxOS-178 v2.2.3
cwdy4 183 targets at this time.

[f a variable name is entered in the Add Monitor dialog, the Memory view
may display incorrect content when the DSF debug engine is used.

Debugging is not supported for LynxOS-178 targets running in
Production Mode.

Host Shell
« The Host Shell view does not support ncurses based applications.
« The Delete button works the same way as the Backspace button.
« The Host Shell icon can be disabled on the toolbar. To enable it, click a
project or its subdirectory in the Project Explorer view.
Host File System

A file selected in the Project Explorer view cannot be dragged and
dropped in the Host File System view if the Host File System view has the
selection on a file entry.

On the Windows Host, changing the read only attribute of a folder is not
supported.

16 Luminosity v5.1.1 BETA Release Notes
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Direct Access

On Redhat Linux 6.x, if SELinux is installed, the direct access to
targets/hosts may not work if the selinux-policy RPM package has
version 3.7.19-126. Update the packages to version 3.7.19-154 or higher.

Direct access is not supported for LynxOS-178 targets running in
Production Mode at this time.

Remote File System View

The contents of a directory where the current user has read only
permissions is not displayed.

Working with the Remote File System view via a serial line may run
unusually slow. Use a network connection if possible.

If the Remote File System view is closed while obtaining information from
the target, an error message may be displayed.

The Remote File System view is not supported for LynxOS-178 targets
running in Production Mode at this time.

Remote Target System Viewer

Working with the Remote Target System Viewer via a serial line may run
unusually slow. Use a network connection if possible.

The Remote Target System Viewer reports errors if started while a kernel
debug session is open.

The Control terminal column is empty in the Processes view if the
LynxOS-178 target is running in Production Mode.

The Process view displays double 1wsrvr process entries if the Show
process hierarchy option is enabled.

The CPU ID column is empty in the Process view if the LynxOS-178
target is running in Production Mode.

In the Summary view, load average values may be incorrect on
LynxOS-178 targets.

Luminosity v5.1.1 BETA Release Notes 17
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[f a target is rebooted when the Target System Viewer is running, the
connection may break and the Reconnect button is displayed. If clicking
this button does not restore the connection, close all views using the Close
All button and click the Remote Target System Viewer icon again.

The Remote Target System Viewer may stop running intermittently
showing the Connection is lost message. Use the Reconnect button
to restore connection with the target. This situation can occur if the date is
set incorrectly on the target.

The Preference setting of views that should be opened in the Remote
Target System View can be safely ignored.

SpyKer

After the Zoom tool is used, the ruler may contain no time labels. Scroll
the event panel to the left or to the right to show the nearest time label.

Events with the same timestamp cannot be viewed by the SpyKer tool
separately from each other and are always “aggregated™ in the display.

For wrapped traces the SpyKer tool may mislabel the name of a thread
when the original thread exits and the thread ID is reused by a new
thread.

To allow the SpyKer tool to load large traces (>2.5 MB), the Java heap
size should be no less than 25 times the trace size. To increase the Java
heap size, restart Luminosity using the following command:

./luminosity -vmargs -Xmx<size>m

where <size> is the Java heap size in MB.

NOTE: Even larger heap may be required to perform various operations with the
trace. If the Java out of memory error message appears, restart Luminosity with
an increased Java heap.

When a trace is opened, the following warning maybe displayed:

Warning:there is no cone-to-one correspondence between the
Interrupt events in the trace. The following GUI features may
work improperly:

* TRQ detailed information {(the IRQ tasks)

ISR state indication

18 Luminosity v5.1.1 BETA Release Notes
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* ISR Histogram

This means that there is not a one-to-one correspondence between the
Interrupt and Return from Interrupt eventsina trace.

In most cases these warnings can appear if there are overruns during trace
capture or if the triggers are used.

SpyKer can display the following warning messages for traces with the
Wrap mode event:

Warning: no superviscr/user mode change events for <thread
name> thread after hole.

This means that SpyKer cannot detect the actual state of the

<thread name> thread and will assume that this thread is always in the
system state.

If library calls are traced, but the Capture Arguments box is not checked,
the trace display tool reports arguments as zero.

The Measure tool does not resize the measure bar after resizing the
window.

After using the tool, the scroll bar position does not match an updated
window.

In the Memory Usage panel, if the Kernel memory value is negative, the
user memory histogram can be outside of the top or bottom edge of the
panel.

Collecting a SpyKer trace via serial line is slow. Use a network
connection if possible.

When a trace is being searched then after the last event is detected. and
the trace is clicked, the vertical line which marks the found event
disappears and “Event not found” is shown in the bottom string. One
more click starts searching from the point of the trace that is clicked.

In a SpyKer on-line document, the links may not work if a keyword
search is performed.

When a new event is added in the SpyKer Events preference dialog, to
enable the buttons located on the right, click an existing event in the
appropriate table.

The SpyKer trace collection may fail if the target is heavily loaded.

Luminosity v5.1.1 BETA Release Notes 19
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Once a trace is collected and the Display button is clicked, the
Disconnected I/0 error message can appear in the Log box. This
message may be safely ignored.

Only 4 CPUs are marked in a SpyKer trace with color.

The library instrumentation feature is currently unsupported for
LynxOS-178 targets.

GUI Issues

The Cross-Development Platform Configuration dialog contains an
additional External BSPs box and the Manage button which are not
described in Luminosity User's Guide. They are used only in case the
Cross-Development Environment supports BSPs external to the system
tree.

The appearance of the Remote Target Configuration dialog differs from
the one present in the Luminosity User's Guide. All controls described in
the Guide are present but are located in General, Network, and Serial sub-
tabs.

Remote File, Remote File System, Target System Viewer, SpyKer, Remote
Shell, Application Debugged, and Host Shell views if opened using the
Window -> Show View menu item do not display any contents. Use
corresponding Lynx menu items or toolbar icons to open these views.

The Luminosity IDE may hang for a few minutes if a large binary is
expanded in the Project Explorer view.

If a view is maximized and then minimized the right ruler containing
minimized icons may disappear and the view becomes unavailable. Use
the Window -> Reset Perspective main menu item to make it available
again.

[cons on the toolbar of the Target System Viewer view may sometimes
appear absent. Resize the workbench window in order to make them
visible.
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Targets View

Switching to a new workspace removes the default target selection.

Currently, different remote target entries may not have the same MAC
address.

Remote Copy

When a file 1s copied to a remote target, the progress bar remains empty
not displaying the operation progress.

Copying files via the serial line may appear slow. Use a network
connection if possible.

Copying files is not supported for LynxOS-178 targets running in
Production Mode at this time.

Target Login
+ Target Login is not supported for LynxOS-178 targets running in
Production Mode at this time.
Import
* The Luminosity IDE may not operate properly if an attempt to import a
Luminosity project using the Import => General menu item is made. Use
the Import => LW Projects menu item instead.
» Import of Kernel and driver projects is not supported.
Miscellaneous

A diskless target may printthe No space left on the device error
message when the user attempts to debug or run an application. Rebuild
the KDI reserving more free space in the file system.
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If localhost (127.0.0. 1) is not specified in the No Proxy for list in the
Edit->Preferences~>Advanced->Proxies Mozilla dialog, switching
between local Online Help and Internet pages is not supported. Specify
the localhost in the No Proxy for list.

If the Luminosity IDE ends incorrectly (by receiving a signal), the
lwproxy process can remain running, thus preventing successful
validation of a remote target in the subsequent Luminosity session.
Disable this process before launching Luminosity again.

SSH and FTP types of connection with the target do not work if the user
account has no password.

The Help -> Check Update dialog produces an error. This function is not
supported.

If License Manager is running with a cross platform that is registered in
Luminosity IDE during the precise moment that Luminosity starts, an
error message may be displayed. You can safely ignore this error
message.
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